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    1 Introduction




    1.1 Foreword




    After having seen a great number of participants of the Project courses I have held during the last few years, a circumstance common to most of them had clearly arisen, and it’s the fact that almost always the Project Management basics and terminology are lacking. Unless the participants have not already taken part in a course of project management methodology or that themselves are applying project management structured and well defined processes, everyone finds it difficult to follow the logical flow of MS Project’s tasks with the consequence of getting lost within this complex software’s intricate world of commands and menus.




    I believe that in order to reduce the effort and to better understand MS Project’s potential, it’s advisable to have applied or at least seen a formal project management methodology (PMI, Prince2, APM).




    In its latest Project edition, Microsoft has continued the effort of aligning its software with PMI’s (Project Management Institute - http://www.pmi.org) methodology requirements, especially in reference to the processes and glossary described in PMBok 4th.




    As a consequence, who has a good understanding of the methodology or who reads in-depth the PMBok, will certainly have to strive less in learning MS Project and in putting into practice many of the methodology’s processes.




    1.2 How to use this tutorial




    The reason for which I have written this tutorial is that I don’t consider the more or less professional books on Project available in the bookshops as a support for training classes (my Project shelf has bent under the weight of those I have bought!). Most of the available textbooks are 600 page reference books full of pictures and tables where all the features, menu items, toolbars and so on are listed.




    What was lacking, at least for me, was an English textbook with an informal and colloquial approach having many pictures and written in an easy and essential language. Moreover, for a person who is approaching for the first time new concepts and such a complex program, it’s of no use to start by looking up a book full of details on all of Project’s features.




    Later, when we will have learned the basic concepts and started implementing them on actual projects, we will be able to use these reference books to learn new commands and details.
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    Figure 1 - Microsoft Project’s start up screen




    1.3 What is Microsoft Project




    Microsoft Project 2010 (both in the Standard edition as well as in the Professional one) is a very advanced software for carrying out project planning and control.




    Rightly or wrongly MS Project is the most widespread planning software in the world (and also the most copied or with interfaces to import/export its files), especially in the Windows environment.




    The user approaching MS Project for the first time, has to be aware that it’s a very complex and sophisticated software and that, in my opinion, he or she has to adapt to its philosophy and to its way of reasoning, and vice versa should not try to force it to work differently from how it’s been programmed.




    Moreover, I have been able to ascertain personally or through personal acquaintances, forums and MS Project specialised blogs that it’s preferable to approach it with the help of a trainer resisting the temptation of self-teaching it. It’s advisable, in my opinion, that someone shall guide us to using MS Project correctly avoiding to pick up bad habits which will mine our confidence in this tool even to the point of giving it up or of using it marginally.




    In this guide I try to lead you during the learning of the best practices for the use of MS Project 2010 (which almost all can also be extended to MS Project 2003 e 2007 except for the different graphical interface and the absence of the new features).




    In order to get acquainted with Project, it’s also advisable, for the next chapters, to practice with the menu items, toolbars and contextual menus (that can be called up with the right click of the mouse).




    For almost all the commands, Project allows different alternative ways for the same command. As one gets better acquainted with Project each one will use the preferred command mode.




    1.4 Project’s screen




    As it can be seen in Picture 2, the Microsoft Project screen has a graphical interface which is very similar to the one of the Microsoft Office 2007 and 2010 applications, but quite different from the MS Project 2003 and 2007 editions. And it’s the very interface the first stretch of the new version’s learning curve which is very steep.




    The people who have never used MS Project in the past will not have special problems in this respect, while who has already used the previous editions will have to make a greater effort to adapt to the new interface.




    Note: In case Project Professional 2010 is used WITHOUT the connection to Microsoft Project Server 2010, the items of the commands within the ribbon tabs and groups are almost identical with Project Standard 2010
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    Figure 2 - The MS Project 2010 screen




    1.5 Microsoft Project 2010 screen’s main elements




    If we carefully look from top to bottom at Project’s screen immediately after start up, we will find various specific elements and precisely:
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    Figure 3- Ribbon Tabs
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    Figure 4- Task Tab




    This tab contains the commands needed for creating tasks, subtasks, summary tasks and milestones. Here we can also find the tools to move, copy and remove tasks, manage the outlines, i.e. the indentation for the various task and subtask levels. During the project update phase we have here the commands for updating the tasks and project status.
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    Figure 5 - Resource Tab




    In this tab we can find all we need for managing the resources. Here we can find the commands for viewing the Team Planner view and the Resource Sheet view, and the resource levelling commands.
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    Figure 6 - Project Tab




    In this tab we have the commands for assigning some of the project’s features, the commands to define the calendars, insert subprojects, create links between projects and reports.
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    Figure 7 - View Tab




    The View panel contains the buttons for calling up the most important views for the Tasks and Resources, the commands to filter the information, such as the outline levels to be viewed, the tables and views to apply.
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    Figure 8 - Format Tab




    The Format tab contains the most used commands for formatting the gridlines, the project bars. Depending on the views active in Project’s window, this tab presents the various formatting and viewing options.




    A common feature to all the Ribbon Tabs is illustrated in the following picture:
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    Figure 9 - Tab’s main components




    • (1) Quick access toolbar




    • (2) Tab Drop-down lists of specific commands




    • (3) Dialog box launcher buttons




    If we stop a few seconds with the mouse over the icons of the various elements in the tabs, Project will show the Tooltips, which are one or more quick explanation words for the meaning of the command.




    Tip: If we click on the little button as shown in the following picture, Project will minimise the ribbon in order to give more room for the project information. Clicking again on the same button (which will have changed its icon), the ribbon will be shown again.
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    Figure 10 - Button to minimise the ribbon
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    Figure 11 - Project reduced view




    If we resize Project’s main window, the ribbon is redrawn so to show as much as possible of it and to allow us to access the groups with the commands.




    1.6 Indicators and Smart Tags




    Project 2010 shows up some indicators to inform us of special conditions that deserve our attention or to suggest actions after a command is executed.




    In the following picture
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    Figure 12 - Indicators and Smart Tags
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          (1) The Indicator is informing us about the existence of a constraint for the task.
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          (2) The smart tag displays the actions suggested (in the example we have deleted the content for the Task Name field).


        

      


    




    1.7 File Panel’s commands




    In the following picture the content of the New Tab is shown after having clicked on the ribbon File Tab.
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    Figure 13 - New File




    Some commands in the Backstage view don’t require any explanation.




    We are talking about Save, Save as, Close, Exit.




    The Info Tab contains some information about the current project. It’s the same information that we can see from the dialog box called up from the Project Tab and then Project Information as in the following picture.
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    Figure 14 - Project information details




    Always in the Info Tab we have the button to call up the dialog box for managing the Project Server 2010 connection account, as shown in the next picture.




    [image: image]




    Figure 15 - Project Server connection details




    To finish with, always in the Info Tab, we can find the button that calls up the Organizer which allows us to manage the items stored in Project’s Global Template (Global.MPT).




    In the following picture we shall just see a preview:
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    Figure 16 - Project’s Global Template




    Other Tabs available in the Project’s Backstage (File Menu) are:




    Recent, lists the most recent Projects files opened. In the following picture
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    Figure 17 - Recent project handling




    We can see (1) the list of the most recent files opened, (2) how many files to be placed in the (3) quick file access list.




    New, contains the various options for creating a new project. We will see them a little later on.




    Print, contains the options for printing the various parts or the whole project.




    Save & Send, contains the options for saving the project in different versions or for sending it by e-mail.




    Help, the new version of Project’s Guide.




    Options, surprise! Here we can find the equivalent of the commands which in Project’s previous versions could be found in Tools / Options.




    1.8 Project’s screen’s elements




    In the following picture we can see the different parts of Project’s screen.
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    Figure 18 - Project's screen in detail




    Carefully looking at the previous picture, we can notice that in the lower part of the screen there is a pane full of details.




    There are different modules in Project, each one contains specific information.




    This kind of view in Project is defined as Split View. Both simple views (full screen) as well as split views (upper and lower pane) can be created in Project.




    Let’s see for example another split view where the upper pane is identical to the one in the previous picture, but different for the lower pane:
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    Figure 19 - Different pane in the lower part of the screen




    1.9 New project




    In order to create a new project, open from the backstage the File Tab (1) and then New (2). The following view will be displayed
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    Figure 20 - Commands available for creating a new project




    Different routes can be chosen to create a new project.




    If we wish to create a new project from scratch it’s sufficient to select the Blank project button and click on Create (3).




    Project’s standard window will be displayed.




    From Recent templates we can select, among the latest used, the template that interests us and from this Project will create a new project identical to the template.




    In My templates are listed the templates we have saved in our computer or that we have added to Project’s Global Template (Global.MPT).




    From New from existing we can create a new project starting from one “that has worked” or that some colleague of ours has sent us. If the project we want to start from has really been useful to us, we have achieved a correct balance between the effort and the results, then it’s advisable to turn the project into a template cleaning it of the unnecessary information and to “standardise” tasks and resources.




    A new project can also be created with New from Excel workbook. If we have one or more Excel sheets containing tasks to be carried out in the new project, maybe created by other project members, it will be possible to import them into Project transforming the Excel list into the corresponding tasks.




    Finally, from the Office.com Templates area, if we are connected to Internet, it’s possible to download several Project plan templates available from Microsoft’s website and subdivided in different categories.




    1.10 Entering the project’s start and end dates




    By definition, each project has a predefined and hoped for start date and a finish date, obviously. Project allows us to enter this and other information quickly and in a single place.




    Let’s go to the Project Tab and let’s click on the Project information button.
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    Figure 21 - Opening Project details




    We will have on screen:
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    Figure 22 - Entering the start and finish dates




    Let’s see the meaning of the information in this window.




    Field (1) represents the expected project start date and depends on the value in field (5) if set to Project Start Date. If the latter field is instead set to Project Finish Date, then the Start Date will be disabled and it will be possible to modify the (3) Finish Date field. In this last case we will have a backward pass scheduling, i.e. from the project’s finish date backward in time.




    Normally the project’s scheduling is carried out in forward pass mode i.e. from today onwards. Knowing the project’s starting date, entering the tasks and the duration, Project will automatically calculate the project’s finishing date. It will be our care and skill to make sure that it will not be too far ahead in time otherwise the project’s ending date will slip and expected costs will rise, thus becoming unacceptable to the client.




    The (2) Current Date field displays the computer’s current date. Anyhow we can change it as we please in order to carry out simulations or for the project’s tracking phase.




    The (4) Status date field represents the date by which we wish to update the project during its execution. Normally it coincides with the date by which we have the final date for the resources’ working hours and for the accrued costs.




    The (5) Shedule from field represents the scheduling method, Forward Pass or Backward Pass




    The (6) Calendar field displays which is the base calendar assigned to the project.




    It’s possible to do so that each time we create a new project the Project Information window will be displayed. To do this call up the backstage from the File Tab, select Options and then from Advanced select Prompt for project info for new project as shown in the picture:
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    Figure 23 - Advanced options for the projects




    1.11 Attaching documents to the project




    It’s possible to attach to the project documents which are useful for the planning tasks and for the state of the work. Obtaining this is very simple.




    In Project it’s possible to add hyperlinks in any suitable field. Typically a column has to be added in the project plan’s Table area and we will associate the hyperlink field as in the picture:
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    Figure 24 - Hyperlink field




    In order to achieve what is shown in the previous picture, one has to right-click on the Task Mode column heading and select Insert column from the context menu displayed.




    From the list of fields listed, look for and select Hyperlink and it’s done.
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